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observed values are depicted as an image and as a single N-S profile (labelled “Subset 2” on 
the plan).  The observations are represented as blue crosses on the plan.  In the profile 
window the blue crosses in the top pane represent the observed field values (TMI in this 
case).  The bottom pane is used to depict the subsurface.  The green crosses mark the 
actual position of the observation sensor (the aircraft in this case).  The line below the green 
crosses represents the topography, and has been generated by subtracting the ground 
clearance (radar altimeter) from the true (GPS) height of the sensor. 

What is Potent? 
Potent is a program for modelling the magnetic and gravitational effects of subsurface 
structures.  It provides a highly interactive 3-dimensional environment that is well suited for:

• Detailed ore-body modelling for mineral exp
and exploration companies world-wide. You can interpret surface, airborne and 
down-hole data; separately or simultaneously. 

Stratigraph• ic modelling for petroleum exploration. Potent is an economical, 
versatile and highly interactive tool for building models of complex layered 
structures. 

• Education. Educational establishments around the world use Potent for teaching 
and research purposes. 

• Environme
studies and to h

Potent can model multi-c
tensor gravity data. 

Main concepts 
The main concepts in Pot

• Observations 

• Calculation 

• Visualisation 

  
The primary function of the program is to bring these together in a coherent and intuitive w

Observations 
These are the “facts”.  Someone has measured one or more physical quantities (total 
magnetic intensity, vertical gravity, etc.) at a set of known locations.  The only uncertainty
in any inherent “noise” or, if you are using gridded data, in the interpolation process that was 
used to generate the grid values from the original “true” values. 

This example shows observed TMI data from a small fragment of an airborne survey. The 



 
  

There is no inherent limi
For example, you could l

t to the number of sets of observations that you can input to Potent.  
oad TMI airborne data, down-hole 3-component magnetic data, and 

A Potent model consists of an assemblage of simple 2-D or 3-D geometrical bodies such as 
cylinders and ellipsoids.  Your main task as an interpreter is to devise a model that is 
geologically plausible and also is consistent with the observed physical values 

This graphic shows the same data as in the previous topic, but with a model consisting of a 
single ellipsoidal body. This could be a grossly simplified representation of an ore-body. 
Notice that the right-hand window (the plan) has been zoomed (using the Tools | Zoom 
command) to make the body more visible. 

gravity road-traverse data simultaneously. 

  

See also:  -  Working with Observations in the User’s Guide. 

  

Back to Main Concepts 

Model 



 
  

See also  -  Working with the model in the User’s Guide 

  

Back to Main Concepts 

Calculation 
The model is consistent with the observed physical values if its calculated field matches the 

 (subjective) degree of precision.  You assess this by calculating the 
field (TMI in this case) due to the model and comparing it with the observed field. 
observed values to some



 
In this image the red curve in the profile window (top left) is the calculated field due to the 
model. A third window (bottom centre) has been introduced to show the calculated field as 
image. In an actual modelling session you would proceed to adjust the shape, position and 
physical properties of the model so that its calculated field correlates well with the observe
field.  Note that Potent calculates the field due to the model at the actual observation poin
These are the only p

an 
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oints at which the observed field is known, and from a modelling point of 
view it is not necessary to calculate the field elsewhere. 

  

See also  -  Calculating the field due to the model in the User’s Guide. 

  

Back to Main Concepts 

Visualisation 
You subjectively assess the “match” between the observed and calculated physical values by 
visualising them in the most appropriate manner.  Visualisation is an inherent part of the 

odelling process, as shown in the previous graphics. m

  

See also  -  More about visualisation 

A simple tutorial 

 

This tutorial is aimed at familiarising you with the main features of Potent as quickly as 
possible.  It takes you through a very simple forward and inversion modelling exercise 
without giving any in-depth explanations along the way.  It is concerned mainly with pointing 
you at the relevant operations. 



Run Potent 

Import observations from an XYZ file 

Visualise the observed values 

Creating a subset 

The Model 

More about visualisation 

Inversion modelling 

Run Potent 
To make sure that you have a “clean” environment, exit Potent if it is already running and 
then run it again.  You should see a window similar to this: 
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Import observations from an XYZ file 
We want to import observed data from an XYZ file, so click the button labelled Import 
observations….  You will be presented with a standard Windows file-chooser dialog.  You 
need to locate a file named Example1.xyz that came with your Potent installation disk.  By 
default it will be in a subfolder of the folder into which Potent was installed. (We suggest you 
make a working copy of this folder and its contents somewhere in your Documents area.) 
This file contains some synthetic magnetic data. Once located the file dialog should look 
something like this: 



 
  
Click Open to open the file. Potent displays the Options for reading observations dialog 
box (see below) which allows you to specify the format of the data in some detail. The bottom 
group of controls in the dialog box contains a Preview window, which displays the first few 
lines of the file. Firstly, select Use smart preview, then use the mouse to set up the rest of 
the dialog box as shown below. (Using the mouse animates the procedure, which makes 
things clearer.) Refer to Using smart preview in the User’s Guide for more information. 

You can see that channel 1 contains X (in metres), channel 2 contains Y, channel 3 contains 
Z (0 in this case) and channel 4 contains the observed TMI field (in nanotesla).  These 
channels are reflected in the dialog box Column position settings. (Notice that this is a Free 
field format file and so Start col and End col are disabled.) 

Make sure that Subtract averages from field values is cleared, as we know the data is 
synthetic and contains no background field. 



 
  

Click OK to read the dataset.  Potent displays it in a plan window.  Each observation point is 
represented by a dot.  Each data line has a small button at one end.  Potent was able to 
identify the lines from the Line records that are in the XYZ file. If the mouse cursor hovers 

 over one of these buttons a small window pops up showing information about the line (which
is a “subset” in Potent terminology). (You can right-click on a button to edit the properties of 
the subset.) 



 
 

Back to A Simple Tutorial 

 
 click Options on the popup menu (equivalent 

Visualise the observed values
Right click anywhere on the Plan window and
to c klic ing Options in the Window menu). 

 
Select the Observations tab of the Plan window settings dialog box. 



 
  
In the Show image of group, select Observed field . 

   
  
Click OK.  The Plan window should now look like this: 



 
  
You now have an image of the observed field.  As you move the mouse cursor over the 
image the status bar displays the (X,Y) coordinates and the underlying interpolated field 

lue, F. va

 
(The wobbly nature of some of the contours in the example makes this a good place to poin
out that Potent uses a very fast minimum curvature gridding algorithm. The grid, and its 
associated contours, are present to help you to visualise the interpretation process, and a
not intended to compete with the output of specialised gridding applications. In particular,
interpolated grid points are not used in any modelling calculations; these are always don
the observed data locations.) 
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It is usually desirable to look at the data as one or more profiles.  When the data has been 
imported from an XYZ file the original line structure is already present.  These lines are the 
simplest sections to display in profile form.  We shall display the N-S profile for line 400E.  If 
you hover the mouse cursor on the small grey button that marks the end of each line a small 
popup window is displayed that contains basic information about the line.  The path of the 
line is drawn temporarily on the plan. 



 
Having identified line 400E click the left mouse button on the line marker button.  A Profile 
window is created alongside the Plan window.  Resize the profile window so that your 
configuration looks like this. 

 
  
This Profile window consists of two panes.   

• The top pane displays the original observed field values in profile form, drawn as blue 
crosses in this case.  (The red line is the calculated field.  As there currently is no 
model, these values are all zero.)  The horizontal axis P (for “profile”)is the distance in 
metres from the start of the profile.  The vertical axis is the observed TMI in 
nanotesla.  (Note that the interpolated values that form the image on the plan are not 
used.  The only function of the image is to help guide you around the really important 
entities, the observed values.) 



• The bottom pane is the cross-section pane.  The vertical axis, Z, is height and so the 
negative values represent depth.  The window essentially contains a cross-section of 
the sub-surface, and will eventually contain a representation of the model.  The green 
crosses are the observation points, which are all at height 0m.  The cross-section 
pane uses the same horizontal axis as the profile pane. 

At this point we could click on further line marker buttons on the Plan to open more N-S 
profiles.  However, we shall look at a more general way of creating a profile. 
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Creating a subset 
The subset is one of the key concepts in Potent.  In complex or large datasets it is important 
to be able to home in on features of interest.  We can use the current very simple example 
dataset to demonstrate the subset concept by creating a profile at an oblique angle across 

ber 

From Potent’s Tools toolbar (or by dropping down the Tools menu) select the Subset - box 
tool. The mouse cursor changes to the shape indicated on the toolbar button.   

the anomaly shown in the Plan.  

(For a long, narrow subset the Subset – box tool is most appropriate. However, remem
that the Subset – polygon tool allows you to create a subset of arbitrary polygonal shape.) 

 
Using this cursor, drag a line diagonally across the Plan as shown.  (Press the left mouse 
button at the start of the line.  While holding the button down, drag the cursor to the other end 
of the line and then release the button.)  The Create subset dialog box is displayed.  If you 
make a mistake just cancel the dialog box and try again. 



 
  
You define a subset by specifying a rectangular selection of the data.  Click on the small UP 

row attached to the edit box lab lled Width of enclosing rectangle.  The line you dragged ar
with the mouse expands into a rectangle.  For the purpose of this exercise make the width 
50m.  Your screen should look like this. 

e



 
  
In this case the subset is going to be long and narrow.  The subset is simply a sample of the 
observed data (not the interpolated points underlying the image).  You can choose to display 
it in a Plan, Profile or Down-hole window initially, or not display it at all, by choosing the 
appropriate button in the dialog box.  In this case we want a profile window, so click on the 

tton labelled Create subset and open a profile window. bu



 
  
The new window should have positioned itself neatly below the previous profile window.  It 
contains clusters of points from each of the lines of observations that were covered by the 
rectangular area you created.  You can see this more clearly by altering the plan slightly.  

Options on the popup menu.  Select the Right click anywhere on the Plan window and click 
Subsets tab of the Plan Window Settings dialog box.  In the Mark data subsets group 
select With colours and Show profile rectangle.  Click the Apply button and the Plan 
window should look like this. 



 
  
(Click Close to dispose of the dialog box.)  The rectangle on the Plan corresponds to the one 
you created when you defined the subset.  The red crosses lie within it and represent the 
observation points that are included in the subset.  You can see that the clusters of points in 
the new profile window result from the projection of the points sampled from each data line 
onto the plane of the profile. 

Click Subset management on the Observations menu to display the Subset management 
dialog. 



 
You can use this dialog box to view all the subsets for the current dataset.  The first subset is 
always All observations (i.e. the entire dataset).  In this example there are also 11 
predefined subsets corresponding to each line defined in the XYZ file.  The last subset 
(Subset 13) is the one we created.  Note that the first profile window did not create a new 
subset; it merely displayed the predefined Line 400E subset.  Using the Plan, Profile and 
Down-hole buttons you can display a subset in as many different windows as you wish.  
Click Close to dispose of the dialog box. 
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e Model 

dit the model. Note that the 
Composite Edit Body dialog box provides identical functionality in a single dialog box. 
However, it does require a large display, or a dual monitor system. Refer to the description of 
the Show composite Edit Body dialog command in the Reference Manual for more 
information.) 

Ensure the Plan window is the active window by clicking on its title bar.  On the Bodies 
toolbar, click Rectangular prism.  

Th
We shall now create a model that is consistent with the observed data.  Remember that the 
observations are synthetic and that no geological realism is suggested! 

(The example given here uses a tabbed dialog box to e

 
This creates a body with the shape of a rectangular prism near the centre of the Plan 
window.  Notice that you can also see the body on the profile windows. 



 
  
Potent assigns the body a default set of parameters (shape, position, physical properties).  
The first thing you must do when you create a body is to make these parameters more 
sensible.  Also note that the calculated field is still zero.  The body is inactive, and you must 
explicitly make it active. 

Edit the body either by choosing the Edit model command form the Model menu or, more 
all cross that marks the top centre of the easily, by clicking the right mouse button on the sm

body (any window will do).  The Edit body tabbed dialog box is displayed. 



 
  
Notice that this dialog box has tabs for Shape (which depends on the type of the body), 
Position (including rotation), and Physical properties (including remanent magnetisation), 
giving you complete control over the body parameters.  Although we will not use them just 
now, the dialog boxes corresponding to these three tabs look something like this. 



 
  
In the General tab, set the
assigned colour, and its ca

 body’s Status to Active and click OK.  The body is drawn in its 
lculated field is displayed on the profiles. 



 
  
(Some systems have problems rendering the bodies as solid objects. If at this point the body
is not drawn as a solid object as shown above, click Always draw bodies as wireframe on 

 

hat will always be 

ntre of the Northern Territory of Australia, latitude 19S, longitude 134E.  We obviously 
ducing field. 

Model menu to display the Inducing field dialog box, where you 

the Model menu.  The solid body will be replaced by a wireframe drawing t
drawn correctly.) 

Magnetic interpretation experts will observe that the calculated field displayed on the profiles 
is that for the north magnetic pole.  However the synthetic dataset was generated for the 
ce
need to set the appropriate in

Click Inducing field on the 
can set the IGRF for your survey area. 



 
  
You can set the parameters in various ways (refer to the Model | Inducing field command in 
the reference Manual for details). For the purpose of this example, click on the map in 
northern Australia (roughly where the cursor is shown) to put the field values in the Strength, 
Declination and Inclination boxes. Then click OK and the calculated field is updated on the 
profiles. 



 
  
Click Move bodies on the Tools menu or the Tools toolbar.  

 
On a profile window, position the new mouse cursor over the small cross that marks the top 
centre of the body.  The cursor changes to a small square.  Hold down the left mouse button 

file window you can move the 
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and drag the body around the window.  Notice that with a Pro
body vertically, and horizontally along the line of the profile.  Notice also that as you drag the
body around its coordinates are displayed in the status bar.  Drop the body at a depth of 
around 100m (ie. Z = -100).  Try dragging the body around on the Plan.  This time you ca
alter its X and Y position, but not its depth.  Put the body into a position something like this. 



 
  
Display the Edit body dialog box again (by right clicking on the cross marking the top of the 
body).  Select the Position tab. 

 



  
Experiment with adjusting the translation and rotation parameters with the small arrows 
attached to the edit controls.  Note that you can change the sensitivity of the arrows by right 
clicking them.  In this example the sensitivity of the Strike adjustments will be set to 10 
degrees per click. 

 
 

  
Back to A Simple Tutorial 

13BMore about visualisation 
Visualisation is an inherent part of using Potent – you can’t use the program without doing 
some visualisation even if it is just displaying a single profile.  In the next exercise we’ll look 
at some more advanced ways of visualising your modelling session. 

First of all make some room on the screen by closing the diagonal profile window in the usual 
Windows way and then reorganising the other windows so that they look something like this. 



 
  
On the Observations menu, click Subset management.   

 
  
Remember that the first subset represents the entire dataset.  Select it and then click Plan 



twice to create two new Plan windows.  Click Close to dismiss the dialog box.  Reorganise 
the two new Plan windows like this. 

 
  
Right click on one of the new Plan windows and click Options on the popup menu to display 
the Plan Window Settings dialog box.  Set up the Subsets tabbed page as follows (don’t 
forget to select Apply to all existing plan windows): 



 
  
Click OK.  Potent applies the settings you have specified to all the plan windows.  In this 
case it means that the subsets are not marked. 



 
  
Right click on the new Plan window at the bottom left and click Options on the popup menu 
to display the Plan Window Settings dialog box.  Click the Observations tab, then click 
Calculated field in the Show image of group. 



 
  
Click OK and the image of the calculated field appears on the plan. 



 
  
Using the same technique, display the image of the residual field (observed minus 
calculated) in the remaining plan window. 



 
  
You now have three images visualising the observations and the model.  Experiment with 
manipulating the model so as to make the observed and calculated images look similar.  The 
residual image highlights the places where the match is poor. 

One problem with the images is that by default Potent stretches the colour range so that the 
minimum value is purple and the maximum red.  Therefore even when there is good 
correlation between the observed and calculated fields the residual will still look 
unsatisfactory (although numeric values as displayed on the status bar would be seen to be 
small).  It would be better to display the residual image using the same colour stretch as the 
observed field.  You can do this as follows: 

Right click on the plan window that displays the observed field and click Options on the 
popup menu to display the Plan Window Settings dialog box.  Click the Observations tab, 
then click Image properties. 



 
  
In the Colour stretch group, the Maximum and Minimum values correspond to red and 
purple on the image.  Potent has calculated these automatically because Auto is selected.  
Clear Auto and select Apply to all existing images…. 



 
  
Click OK to apply the changes and exit this dialog box, and OK again to exit the 
Observations dialog box.  The three images will all be displayed at the new colour stretch. 
Clearing Auto for the colour stretch of each image has prevented Potent from automatically 
recalculating it. 



 
Now, as your model improves, the residual image will tend to a flat shade of blue. 

(As this window configuration will be used in the inversion exercise in a later topic, consider 
using the File | Save workspace as command to save the entire workspace for future use. 
Assign a name pre-invert.pnt.) 

 

Back to A Simple Tutorial 

14BInversion modelling 
Inversion modelling is a mathematical process that automatically adjusts model parameters 
so as to improve the fit between the calculated field and the observed field.  The important 
word here is “mathematical”.  The inversion algorithms used in Potent take no account of 
geological issues; it is up to you, the interpreter, to ensure that the inversion starting 
conditions are sensible, and to reject any inversion results that are not geologically plausible. 

Potent’s inversion scheme is very flexible.  You can invert on: 

• any combination of parameters from any number of bodies; 

• multiple datasets (e.g. regional gravity and aeromagnetic); 

• multiple components from within the same dataset such as three-component down-
hole magnetic data (which you can invert in conjunction with, for example, ground 
TMI data). 

  
In this exercise we shall perform a very simple inversion using a single body and a single-



component dataset. 
  

What’s needed for inversion 

Preparation for inversion 

Inversion exercise 

15BWhat’s needed for inversion 
There are two key items needed for inversion: 

• A set of model parameters that you want the inversion process to adjust; 

• A sample of observed data (X,Y,Z,F values, where Z is height and F is the observed 
field).  This has two functions.  Firstly, the data points in the sample provide the 
geographic (X,Y,Z) coordinates at which Potent will calculate the field due to the 
model.  Secondly, they provide the observed field values, F, against which the 
calculated field values will be compared.  The inversion algorithm (a mathematical 
process) will attempt to minimise the root-mean-square (RMS) difference between 
the observed and calculated values.  

  

Back to Inversion modelling 

16BPreparation for inversion 
Preparation for inversion involves the following steps: 

• Identify the model parameters that you want to adjust by selecting the appropriate 
invert flags in the Edit body tabbed dialog boxes. (When setting the Invert flag you 
also have the opportunity to set a range within which the value will be allowed to 
vary.)  
(For polygonal bodies you will probably choose to use the Invert tool to set up 
inversion on body vertices.) 

• Identify the observations by displaying them in windows.  Close or minimise any 
windows that contain parts of your datasets that are not relevant to the inversion. 

• Consider using the Inversion weights tool to set the relative importance of sections 
of observations. 

• Extract any regional background field by using the Regional tool. 

• Set up a reasonable starting model by adjusting parameters manually.  
“Reasonable” means that your starting model is both geologically sensible and has 
a calculated field that is similar to the observed field. 

  

Back to Inversion modelling 

17BInversion exercise 
This part of the tutorial assumes that your screen is set up as at the end of More about 
visualisation.  

(If you followed the advice at the end of that topic you will have saved the workspace as a file 
named pre-invert.pnt. Use the File | Open workspace command to reload the workspace.) 

 The dataset is Example1.xyz. 



 
  

Remember that the inducing field (IGRF) must be set for northern Australia (near Darwin). If 
necessary use the Model | Inducing field command. 



 
Set up a model that consists of a single rectangular prism with parameters similar to the 
following.  Use the Edit body command to view and edit the model (which is a single body in 
this case).  Note the Invert check boxes.  You are telling Potent to adjust all the Shape and 
Position parameters during inversion, but none of the Physical Properties parameters. 

 
Click Invert options on the Calculation menu to display the Inversion Setup dialog box .  
In this case it has two tabbed pages. 



 
  
The Options tab allows you some control over the inversion algorithm.  Generally you will 
only change the number of iterations.  For this example, set Iterations to 20.  (Apart from the 
Options tab, there is one other tab for each dataset.  Each of these tabs allows you to 
specify the components from each of the datasets that you wish to contribute to the 
inversion, and their relative weights, or importance.  In this example we have only a single 
dataset consisting of a single component, so there are no choices to be made.) 

Click OK to close the dialog box.  Click Invert on the Calculation menu (or Invert on the 
Inversion toolbar).  Potent will proceed to adjust the model parameters to improve the fit 
between the observed and calculated fields.  The RMS error is displayed on the status bar as 
the inversion proceeds.  After about 14 iterations you should end up with a screen like this. 



 
As the data is synthetic we end up with an almost perfect fit. 

If you carried out the inversion exactly as described then it would have proceeded relatively 
slowly.  This is because the grids for the images in the Calculated field and Residual field 
windows must be recalculated at each iteration.  Try using the Restore from snapshot 
command from the Calculation menu to restore the pre-invert workspace.  Then minimise 
(rather than close) the Calculated field and Residual field windows before running the Invert 
command.  The inversion will iterate much more quickly.  Once it is finished you can restore 
the other two windows.  

Note that you must keep open at least one window that contains the whole anomaly.  We 
chose the first (Observed field) plan window in this case.  Any of the plan windows would 
have done, but would have incurred the calculation overhead mentioned earlier. 

Notice that we chose to have a profile window open.  This was entirely for visual effect; the 
inversion would have proceeded perfectly well without it. 

  

Back to Inversion modelling 
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